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About this guidee
This PDF version of the operation guide is provided so that
you can print it in part or in full.

Product version covered
This guide covers SD007-PFX BPChecker3000 version 2.0x.
You can check the version by clicking About xxxx on the
Help menu.

PFX2500 series that this guide covers
SD007-PFX BPChecker3000 can control the following
models.
• Charge/discharge system controller PFX2500 series
• Regenerative battery tester series PFX-R series

Notations used in this manual
• In the interest of brevity, the PFX2500 series Charge/Discharge System Controller/ PFX-R Regenerative Battery
Tester shall be hereafter referred to as the “PFX2500
Series”.
• In the interest of brevity, the SD007-PFX BPChecker3000
shall be hereafter referred to as the “BPChecker3000”.
• The term “PC” is used to refer generally to both personal
computers and workstations.

Copyrights
The contents of the SD007-PFX BPChecker3000 operation
guide may not be reproduced, in whole or in part, without
the prior consent of the copyright holder.
The specifications of this product and the contents of this
guide are subject to change without prior notice.
© 2015 Kikusui Electronics Corp.
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SD007-PFX

IO Config
This guide explains how to use the IO Config to (1) set the model ID and IP address of the Kikusui
PFX2500 series Charge/Discharge System Controller or PFX-R Regenerative Battery Tester, (2) configure temperature chambers, and (3) update the firmware.

BPChecker3000 IO Config
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Starting the IO Config
To start the IO Config, on the taskbar, click Start, All Programs, Kikusui BPChecker3000, and IO Config.
If a security warning window appears at startup, specify the following settings.
Private network: Allow
Public network: Not allow

4

BPChecker3000 IO Config

Before Configuring Settings
Before configuring various settings with the IO Config, you first need to select the channel (the
PFX2512) that you want to configure (in the Select Ch area of the IO Config window). Then, you can
set the model ID and IP address as well as update the firmware. Channels are set on the PFX2512s.

Parts of the Screen
IO Config consists of the Select Ch and Chamber areas and three tabs.

Description

BPChecker3000 IO Config

Select Ch

Select the channel that you want to configure.

Chamber

Set the temperature chamber driver, VISA resource, and the number of
temperature chambers.

Model ID tab

Set the PFX2512 model ID.

Manual Set IP Address tab

Set the PFX2512 IP address.

UpDate Firmware tab

Update the PFX2512 firmware.
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Selecting the Channel
Before configuring various settings, select the channel (the PFX2500 series) that you want to configure under Select Ch.
First, search for the PFX2500 series that are connected, and then select the channel. Be sure to
search even when there is only a single PFX2500 series that is connected.
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1

Under Select Ch, click Serch.

2

Check that all connections are displayed, and click OK.

3

Select the channel you want to configure.

The I/O Configuration window appears. You can view the channel information in this window.
When the progress bar reaches the right end, the search is complete. If no PFX2512s
appear after the search, the PFX2512s may not be connected properly, or there may be
overlapping channel assignments. Check the connections. Then click Connect to search
again.
You can also enter the IP address. After entering the IP address, click Connect.

The target channel and IP address are displayed.

BPChecker3000 IO Config

Setting the Model ID
On the ModelID tab, set the model ID of the PFX2500 series.

1

Check that the PFX2500 series that you want to configure is displayed under
Select Ch.
If a different channel is displayed, select the appropriate channel. If the channel is not displayed, click Serch under Select Ch to search channels.

BPChecker3000 IO Config
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On the ModelID tab, click Select.

3

Select the check boxes for the power supply and electronic load to use.

4

Click OK.

5

On the ModelID tab, click Send.

The Setting of Model ID dialog box appears.

The selectable model ID is displayed.

The Setting of Model ID dialog box closes, and the model ID appears on the ModelID tab.

The model ID is sent to the PFX2500 series that is selected under Select Ch. You can check
whether the ID has been assigned correctly to the PFX2512 by clicking Serch under Select
Ch.
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Setting the IP Address
To use a fixed IP address (when connecting through a switching hub or when connecting directly),
use the Manual Set IP Address tab to set the PFX2500 series IP address.
If you are using DHCP, you do not have to set the IP address.
In the factory default settings, the PFX2500 series IP address is set to a value in the range of
192.168.1.101 to 192.168.1.107 (the value varies depending on the channel setting).
Duplicate IP addresses cannot be used. You can use the IO Config to change the PFX2500 series IP
address to a value in the range of 192.168.0.0 to 192.168.255.254.
On the Manual Set IP Address tab, set the PFX2500 series IP address.

1

Check that the PFX2500 series that you want to configure is displayed under
Select Ch.
If a different channel is displayed, select the appropriate channel. If the channel is not displayed, click Serch under Select Ch to search channels.

2
3

Enter the IP address, subnet mask, and default gateway.
On the Manual Set IP Address tab, click Send.
The IP address is sent to the PFX2500 series that is selected under Select Ch.

To verify whether the IP address has been set correctly, check using the PFX2500 series panel. For
details, see the PFX2500 series operation manual.
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Configuring Temperature Chambers
If you want to use temperature chambers, set the temperature chamber driver, VISA resource, and
the number of temperature chambers.
To use temperature chambers, a VISA library must be installed in your PC.

If you are not using temperature chambers
Set MAX Ch to None.

If you are using temperature chambers

1
2
3

From the Driver list, select the temperature chamber driver.
From the VISA list, select the VISA resource.
Specify the serial port COM number.
(Example) For serial port COM1, select ASRL1::INSTR.

From the MAX Ch list, select the number of temperature chambers.
You can connect up to seven temperature chambers.

When using temperature chambers in tests executed from Test Executive, the Test Executive checks
the temperature chamber settings in the IO Config. The temperature chamber settings remain even
after you close the IO Config.

BPChecker3000 IO Config
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Updating the Firmware
When you update or upgrade BPChecker3000, you may also need to update the PFX2500 series
firmware. If the firmware version is old, an alert is displayed when you run the Test Executive. If this
happens, update the firmware using the UpDate Firmware tab.

CAUTION

Risk of damaging the program. Do not turn off the PFX2500 series while the firmware is being
updated.

1

Check that the PFX25100 series that you want to update is displayed under
Select Ch.
If a different channel is displayed, select the appropriate channel. If the channel is not displayed, click Serch under Select Ch to search channels.
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2

If there are multiple firmware versions available, select the version that you
want to update to.

3

On the UpDate Firmware tab, click UpDate.

4

Turn off the PFX2500 series, and turn it back on.

The UpDate button is available only when there is a firmware version that you can update
to.
The PFX2500 series that is selected under Select Ch will be updated. When updating is complete, a dialog box will appear.

The PFX2500 series will start with the updated firmware.

BPChecker3000 IO Config

Menu Reference
Menu

Description

File

Exit

Closes the IO Config.

Help

About I/O Config

Displays IO Config information.

Help

Displays a help file.

BPChecker3000 IO Config
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Menu Reference
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Test Condition Editor
This operation guide explains how to use the Test Condition Editor to create test conditions for tests
that are executed with the Kikusui PFX2512 Charge/Discharge System Controller.

BPChecker3000 Test Condition Editor
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Test Condition Creation Procedure
This section describes the Test Condition Editor and explains how to create test conditions.
Test Condition Editor is used to create and edit all test conditions related to charging and discharging.

Project (test condition) structure
In a charge/discharge test using SD007, the sequences in a project are executed in order.
Use the Test Condition Editor to set up profiles and projects.

Project
General settings
Battery protection and volt/
thermometer units

Sequence 1
Profile 1 (dynamic)
Profile 3 (CC charge)

Profile template database
Save profile templates created with
the Test Condition Editor to the database.

Profile (Pause)
Up to 256 profiles
Select from the profile
template database.

Profile template 3 (CC charge)
Profile template xxx
Profile template 1 (dynamic)

Sequence 2
Profile 2 (dynamic)
Profile 3 (CC charge)
Profile xxx

Profile template 6 (CC-CV charge)
Profile template 2 (dynamic)
Profile template (pause)
Profile template 4 (dynamic)
Profile template 7 (CC discharge)

Up to 256 sequences

Profile template 10 (I-V characteristics)

Sequence xxx
Profile 4 (dynamic)
Profile 5 (CC charge)
Profile xxx

Project
Set the model information, general settings, and sequences in projects. SD007 executes charge/discharge test at the project level.

Profile template
Set detailed charge/discharge conditions in profile templates.
When you finish configuring a profile template, assign a name to the template and save it in the
profile template database. Profile templates that are saved can be used in other projects.

General settings
Set the model ID, battery information, life judgment, temperature synchronization, etc.
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Test Condition Creation Procedure

Battery protection and volt / thermometer units
Set protection functions, cell voltages, etc.

Sequence
Select profile templates from the profile template database. A sequence is a collection of profiles.
You can set repetition counts and stop conditions.

Link and jump
Set links (use test results as conditions for the following test) and jumps (use factors that cause the
profile to stop to branch the sequence).

Project (test condition) workflow

1

Start the Test Condition Editor.

2

Set the model ID.

3
4
5

Projects and profiles are created using the Test Condition Editor.

Specify whether the OP02-PFX/OP03-PFX option will be used.

Set nominal values, life judgment, etc.
Set protection functions, cell voltages, etc.
Create a profile template.
If you are going to use an existing profile template, you do not have to create a new one.

6

Configure a sequence.

7

Assign a name to the project and save.

Configure a sequence by selecting profile templates from the database. Set the number of
sequence repetitions and the chain feature.

Project creation is complete. You can now start a charge/discharge test using Test Executive.

BPChecker3000 Test Condition Editor
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Starting the Test Condition Editor
To start the Test Condition Editor, on the taskbar, click Start, All Programs, Kikusui BPChecker3000,
and Test Condition Editor.
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Before Creating Test Conditions
Description of the display
Test Condition Editor has five tabs.
You can open the Profile Editor by clicking New on the “New or Edit Profile Template” tab.

Description
General tab

The page that appears first when BPChecker3000 is started. Set nominal
values, life judgment, comments, etc.

Bt Protection and Options tab

Configure battery protection, module, and cell voltage and temperature
(OP02-PFX/OP03-PFX) settings.

New or Edit Profile Template tab Create new profile templates and edit profile templates that are stored in
the profile template database.
Sequence tab

Configure sequences.

Link Jump tab

Displays sequence settings graphically.
Set links and jumps.

Input range
If you enter a value outside the input range, a

mark will be displayed to the right of the text box

and the input range will be displayed. Enter a correct value. If a
to save the test conditions.

BPChecker3000 Test Condition Editor

is displayed, you will not be able
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Creating a Project (Test Condition) File
Creating a new project
To create a new test condition file, click

1

. Or on the File menu, click New Project.

Select the check boxes that correspond to your power supply and electronic
load.
The selectable model ID is displayed.

2
3
4

Select the model ID of the combination to use as a power supply module.
Select the model ID of the combination to use as a power supply module.
If the OP02-PFX volt/thermometer units are installed, select how many are
installed.
The board (EX01-PFX) for using the OP03-PFX is excluded from this count. If you select 1
or greater, the cell voltage test is enabled.
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5

If OP03-PFX voltmeter units are installed, select how many are installed.

6

Click OK.

If you select 1 or greater, the cell voltage test is enabled.

A new project opens, and the model ID that you selected appears under Model Information on the General tab.
Check that the correct model ID and voltage range are selected and that the number of
OP02-PFX and OP03-PFX units are correct.

BPChecker3000 Test Condition Editor

Creating a Project (Test Condition) File

Editing an existing test condition file
To edit an existing test condition file, click

. Or on the File menu, click Open Project.

If you save this file by clicking Save Project As on the File menu and specifying a different file name,
you will be able to create a new file based on an existing file.

BPChecker3000 Test Condition Editor
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Configuring a Project’s General Settings
Under Model Information, the information of the model that you selected when you created the
new project is displayed. You cannot change the model information. To do so, create a new project.

Entering comments
Enter the project name, date, operator name, battery type, and notes.

20

Item

Description

Project Name

Enter the name of the file to save. You can enter up to 20 characters.

Date

Select the type of date to display.

Operator

Enter the name of the operator. You can enter up to 48 characters.

Battery Type

Enter the battery type. You can enter up to 48 characters.

Note

Enter an arbitrary note or comment. You can enter up to 128 characters.

BPChecker3000 Test Condition Editor

Creating a Project (Test Condition) File

Setting the battery information
Set DUT information.
Item

Description

Current Capacity

Enter the nominal current capacity of the DUT.
The nominal current capacity is used as a reference when setting OAH (overcharge
capacity protection). It is used to convert the profile type patterns and I-V characteristic
CC capacity ratio into current values. Enter an appropriate value.

Power Capacity

Enter the nominal power capacity of the DUT.
This is used to convert the profile type patterns and I-V characteristic CP capacity ratio
into power values. Enter an appropriate value.

Voltage

Enter the nominal voltage of the DUT.

Volume

Enter the volume of the DUT.

Mass

Enter the weight of the DUT.

Setting the battery life
Battery capacity degrades or its impedance increases as batteries are repeatedly charged and discharged.
If Life judgement check box is selected, the function determines that the battery has reached the
end of its life when the measured capacity falls below the specified percentage of the nominal
capacity.
Set the battery life judgment conditions. This function terminates the test in the same manner as
when the test is normally completed if it determines that the battery has reached the end of its life.
Battery life judgment is valid for profiles whose Judge Life Enable check box is selected in the
charge/discharge profile.
Item

Description

Capacity Ratio

The minimum capacity rate can only be specified for discharge. The reference capacity value
is the current capacity that was entered in “Nominal Value” which is taken to be 100%.

Judgement Count

Specify the number of failures for terminating the test. For example, if you specify a
value of 9, the test is terminated when the function determines that the battery has
reached the end of its life nine times.

BPChecker3000 Test Condition Editor
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Configuring the Protection Function and the Cells to Be Measured
After the general project configuration is complete, configure the battery protection (software protection) function.
The cells to be measured and groups when OP02-PFX or OP03-PFX units are used are also set here.

Software protection and hardware protection
You can configure the software protection and hardware protection from the BPChecker3000.
The software protection runs on the firmware of the PFX2500 series and is configured using the Test
Condition Editor. If the specified values are exceeded during a charge/discharge test, an alarm
occurs, and the test is aborted.
The hardware protection runs on the hardware of the PFX2500 series and is configured using the
Test Executive.
Applying the hardware protection function protects the DUT (battery) from overcharging and overdischarging, even when charge/discharge tests are not being executed.
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Configuring the Protection Function and the Cells to Be Measured

Configuring battery protection

CAUTION

• This function is used to prevent serious accidents such as damages to or explosion of the DUT (battery).
Unless there is a special reason not to do so, use this protection function when performing tests.
• In case of the incorrect setting, it may generate the trouble such as a damage to the DUT caused by
not activating the protection function under the abnormal operation (when it requires to activate
the protection function), or aborting the test even detected no abnormality.

You must set software protection to protect the DUT (battery). If you do not set appropriate values,
alarms and warnings will occur frequently, and you will not be able to execute the tests.

Each item is enabled only when the check box is selected.
Item

Description

SOVP

Set the OVP (overvoltage protection). If battery voltage exceeds the OVP value during
testing, an alarm occurs and the test is aborted. The accurate overvoltage detection is
possible because of the detection accuracy is the same as the voltage measurement
accuracy. The detecting speed is 150 ms (max).
In normal cases, set a voltage relatively close to the cutoff voltage or CV voltage for charging.
• Delay
Set the activation delay time for the protection function. (the period of time to start
activation of the protection function )

SUVP

Set the UVP (undervoltage protection). If battery voltage falls below the UVP value
during testing, an alarm occurs and the test is aborted. The accurate undervoltage
detection is possible because of the detection accuracy is the same as the voltage
measurement accuracy. The detecting speed is 150 ms (max).
In normal cases, set a voltage relatively close to the cutoff voltage for discharging.
• Delay
Set the activation delay time for the protection function. (the period of time to start
activation of the protection function )

OAH

Set the OAH (overcharge capacity protection). If battery capacity exceeds the OAH
value during charge testing, an alarm occurs and the test is aborted. The value is a percentage with respect to the current capacity that was entered in General.
Set an appropriate value when performing overcharge or overdischarge tests.

OTP

Set the OTP (overtemperature protection). If battery temperature exceeds the OTP
value during testing, an alarm occurs and the test is aborted.
Specify an appropriate value by taking the temperature measurement error and ambient
temperature fluctuation into consideration.
If the temperature measurement is not required (including the case for not connecting
the thermistor), invalid the OTP protection function.

SOCP

Set either valid or invalid of the OCP (Over Current Protection) function.
When the charge current exceeds the OCP value during the test (detected by the AC
converter), the alarm will be activated and abort the test. You cannot set the OCP value.
• Delay
It sets the activation delay time for the protection function. (the time to start activation of the protection function )

BPChecker3000 Test Condition Editor
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Configuring the Protection Function and the Cells to Be Measured

Configuring the connection check function
Configure the DUT connection check function. The connection check function is to measure the
voltage value on each of the output cable and the voltage sensing wire, and if there is any difference in measured voltage value, this function determine the status as abnormal connection and an
alarm occurs. The connection check function activates immediately before the charge or discharge
operation is begun.
Item

Description

DUT Confirm Combine

The connection check function of the DUT (device under test) is enabled if the check
box is selected.
During this period, if the voltage of the DUT varies (the rest time is set to short time,
etc.), it may cause generation of the alarm even when the connection is wired properly. In such case, please disable the connection check function.

Configuring the cell voltage, temperature, and unbalance protection functions

See

p. 18

Configure the cell voltage, temperature, and unbalance protection functions.
The configuration of “Exp.1” tab is valid when multiple OP02-PFXs are selected when a project is
created.
The configuration of “Exp.2” tab is valid when multiple OP02-PFXs are selected when a project is
created.

Slot number where
the OP02-PFX/OP03-PFX
is installed

Terminal number

You can use the Copy and Paste buttons to copy and paste the cell contents.
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Item

Description

Unbalance Margin

An alarm occurs when the unbalance voltage exceeds the unbalance margin.
The difference between the maximum and minimum cell voltages for the terminals
whose UB check box under Protection is selected is the unbalance voltage. The unbalance voltage is detected approximately 0.1 second after the cell voltage measurement
completes. If the charge / discharge voltage fluctuates greatly (the internal voltage of
the DUT is high), this function may not operate correctly. If the measured voltages are
different or sensing cables are not connected to both ends of the cells, this function
will not operate correctly.

Measure

• Volt check box
Measures the voltage of the selected terminal.
• Temp check box (OP02-PFX only)
Measures the temperature of the selected terminal.
• Group check box
The selected terminals are handled as a group. The maximum cell voltage and minimum cell voltage in the group are displayed in Test Executive. These terminals will
be subject to cell CV control. Right-clicking and selecting All Check Group/ All
UnCheck Group selects or clears the check boxes of all terminals.
Selecting a terminal, right-clicking, and selecting Copy to all Channel copies the settings of the selected terminal to all terminals.
Right-clicking and selecting All Check/ All UnCheck enables or disables the measurement functions of all terminals.

BPChecker3000 Test Condition Editor

Configuring the Protection Function and the Cells to Be Measured

Protection
(SOVP, SUVP)

Set the OVP and UVP value. An alarm occurs and the test is aborted when the voltage
at the terminal whose En check box is selected exceeds the OVP value or falls below
the UVP value. Right-clicking and selecting All Check/ All UnCheck enables or disables
the protect functions of all measurement source terminals.
• Delay
Set the amount of time (the delay) before the OVP/UVP begins operating.
• UB check box
The unbalance protection function of the selected terminal is enabled.
Right-clicking and selecting All Check UB/ All UnCheck UB enables or disables the
unbalance protect function of all measurement source terminals.
Selecting a terminal, right-clicking, and selecting Copy to all Channel copies the settings of the selected terminal to measurement source terminals.

Protection (OTP)
(OP02-PFX only)

An alarm occurs and the test is aborted when the temperature at the terminal whose
En check box is selected exceeds the OTP value. Set the OTP value. Right-clicking and
selecting All Check/ All UnCheck enables or disables the protect functions of all
measurement source terminals.
• Delay
Set the amount of time (the delay) before the overheat protection function begins
operating
Selecting a terminal, right-clicking, and selecting Copy to all Channel copies the settings of the selected terminal to measurement source terminals.

BPChecker3000 Test Condition Editor
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Creating Profile Templates
Before configuring sequences, create profile templates.
If you are going to use an existing profile template to configure sequences, you don’t have to create
a new one.
When you set test conditions in a profile template, assign a name to the template and save it in the
BPChecker3000 profile template database.

Profile template creation workflow

1

Select a profile type, and click New.

2

Enter the detailed test conditions (charge/discharge settings, rest conditions,
and end conditions).

3
4
5
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The Profile Editor opens.

To control temperature chambers, enter control settings.
Assign a name to the profile template and save it.
The profile template is saved in the profile template database. The Profile Editor closes.

Repeat step 1 to step 4 to create all necessary profile templates.

BPChecker3000 Test Condition Editor

Creating Profile Templates

Selecting the profile type
First, select the profile type.

Item

Description

CC Charge

This is exclusively for constant current charge. It supports -dV detection and -dT/dt detection based on battery temperature.
It is suitable for charging Nickel-Metal Hydride batteries, NiCad batteries, and lead batteries.

CC-CV Charge

Charge mode in which automatic transition is made from constant current to constant
voltage. It supports CV time and It current detection.
It is suitable for charging lithium-ion batteries and lithium polymer batteries.

CC Discharge

A typical constant current discharge. Termination is possible using voltage and battery
temperature as well as capacity (Ah).

CC-CV Discharge

Discharge mode in which automatic transition is made from constant current to constant
voltage. It supports CV time and It current detection.
As deeper discharge than the CC Discharge profile is possible, it is used for highly accurate
discharge capacity measurements.

CP Discharge

This is exclusively for constant power discharge. If the voltage drops causing the discharge
current to increase, it can be limited using limit current.
Termination is possible using voltage and battery temperature as well as capacity (Ah).

CP-CV Discharge

Discharge mode in which automatic transition is made from constant power to constant
voltage. It supports CV time and It current detection.
As deeper discharge than the CP Discharge profile is possible, it is used for highly accurate
discharge capacity measurements.

Pattern

Seamless charge/discharge that allows CC or CP charge/discharge of up to 10000 steps.
Steps can be imported from Excel even when there are numerous steps, such as in a standard test pattern charge/discharge or simulation pattern.s

I-V Characteristics Seamless charge/discharge that allows CC charge/discharge of up to 10000 steps.
Charge/discharge steps used for I-V characteristic can be configured automatically. When
a test is executed using steps that are configured automatically and the data is acquired,
an I-V characteristic graph can be generated automatically.
Pause

Pauses the test.

After selecting the profile type, click New to open the Profile Editor.
The Profile Editor consists of two areas: Name Setting and Profile Template Setting.

Name setting
area

Profile
template
setting area

BPChecker3000 Test Condition Editor
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Creating Profile Templates

Configuring the CC charge type settings
The CC Charge, Chamber, Data Record Method tabs are displayed. Check box items are enabled
when you select the check boxes.
The following figure is shown as an example of the Constant Current (CC) charge operation. The figure illustrates the transition of constant current charge -> -dV detection -> charge termination ->
charge rest.
Charge time
Maximum voltage

Battery voltage

-dV

Rest time
Charge current

CC Charge Setting
Item

Description

Current

Set the charge current.

Rest Condition
For details on rest conditions, see page 47.
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End Condition
See

p. 48

Set the profile end conditions. If OP02-PFXs are installed, you can also set cell voltage and temperature
end conditions. If OP03-PFXs are installed, you can also set cell voltage end conditions.

You must enter the time.

See

p. 49, p. 51

Item

Description

Time

Set the profile’s maximum time. When the total time elapses, the profile is ended.

Max Voltage

When the battery voltage reaches the maximum voltage, the profile is ended.

Enable Delta-V Functionality

• -dV
Charging ends when the battery voltage drops by a value specified by -dV during
charging. This detection can be disabled during the -dV mask time.
• -dV Mask Time
The -dV detection is disabled during the -dV mask time.

-dT/dt

When the temperature of the battery being charged increases at dT/dt (change per
unit time of minutes), the profile is ended.

Max Temp

When the battery temperature reaches the maximum temperature, the profile is ended.

After you configure the CC charge settings, configure the temperature chamber and date record
method.

BPChecker3000 Test Condition Editor
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Creating Profile Templates

Configuring the CC-CV charge type settings
The CC-CV Charge, Chamber, Data Record Method tabs are displayed.
Check box items are enabled when you select the check boxes.
The following figure is shown as an example of the Constant Current and the Constant Voltage (CCCV) charge operation. The figure illustrates the transition of constant current charge -> constant voltage charge -> CV time -> charge rest. (In this example, charge is complete when CV time is reached.)
Charge time
CV time
Battery voltage

CV voltage

Disharge current

It time

Rest time

It current

CC-CV Charge Setting
Item

Description

Current

Set the charge current.

CV Voltage

Set the voltage value at which the battery voltage moves to constant voltage (CV)
operation.

Cell CV

The cell with the highest voltage among the cells in a group is controlled so that it
does not exceed Cell CV. This function is available only when a group is specified when
OP02-PFX or OP03-PFX units are installed.
Cell CV control and the cell voltage in the end condition cannot be used simultaneously. When Cell CV is enabled, the cell voltage in the end condition is disabled.
Because the control speed is slow, the cell cannot be controlled if its voltage changes
rapidly. This setting is applicable to cells whose internal impedance is 500 mΩ or less.

Rest Condition
For details on rest conditions, see page 47.
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End Condition
See

p. 48

Set the profile end conditions. If OP02-PFXs are installed, you can also set cell voltage and temperature
end conditions. If OP03-PFXs are installed, you can also set cell voltage end conditions.
Cell CV control and the cell voltage in the end condition cannot be used simultaneously.

You must enter the time.
Item

See

p. 49, p. 51

Description

Time

Set the profile’s maximum time. When the total time elapses, the profile is ended.

CV Time

Set the time from when the test enters constant voltage (CV) mode to when the profile
is ended.

Max Temp

When the battery temperature reaches the maximum temperature, the profile is ended.

Enable It Functionality

• It Current
The It current is a current value that you can set as you like for detecting charge current
during constant voltage charging. When It current is detected, after the It time elapses,
the profile is ended.
• It Time
Set the time that needs to elapse after It current is detected to end the profile.

After you configure the CC-CV charge settings, configure the temperature chamber and date record
method.
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Configuring the CC Discharge type settings
The CC Discharge, Chamber, Data Record Method tabs are displayed.
Check box items are enabled when you select the check boxes.
The following figure is shown as an example of the Constant Current (CC) discharge operation. The
figure illustrates the transition of constant current discharge -> voltage drop to the cutoff voltage
-> discharge termination -> discharge rest.
Discharge time

Battery voltage
Cutoff voltage

Rest time
Discharge current

Discharge current

CC Discharge Setting
Item

Description

Current

Set the discharge current.

Judge Life Enable

Enables life judgment on the discharge. See p. 21.

Rest Condition
For details on rest conditions, see page 47.
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End Condition
See

p. 48

Set the profile end conditions. If OP02-PFXs are installed, you can also set cell voltage and temperature end conditions. If OP03-PFXs are installed, you can also set cell voltage end conditions.

You must enter the time.

See

p. 49, p. 51

Item

Description

Time

Set the profile’s maximum time. When the total time elapses, the profile is ended.

Cutoff Voltage

When the cutoff voltage is reached during discharge, the profile is ended, even when
the discharge time has not elapsed.

Capa Voltage

When the battery voltage that decreases with discharging goes below the voltage
capacity, discharge capacity integration is stopped.

Max Temp

When the battery temperature reaches the maximum temperature, the profile is ended.

Curr Capacity

When the integrated current reaches the current capacity, the profile is ended.

After you configure the CC discharge settings, configure the temperature chamber and date record
method.
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Configuring the CC-CV Discharge type settings
The CC-CV Discharge, Chamber, Data Record Method tabs are displayed.
Check box items are enabled when you select the check boxes.
The following figure is shown as an example of the Constant Current and the Constant Voltage (CCCV) discharge operation. The figure illustrates the transition of constant current discharge -> constant voltage discharge -> It time -> discharge rest. (In this example, discharge is complete when It
time is reached.)
Rest time
Discharge time
CV time

Battery voltage

CV voltage

Charge current

It time

CC current
It current

CC-CV Discharge Setting
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Item

Description

Current

Set the discharge current.

CV Voltage

Set the voltage value at which the battery voltage moves to constant voltage (CV)
operation.

Cell CV

The cell with the lowest voltage among the cells in a group is controlled so that it does
not fall below Cell CV. This function is available only when a group is specified when
OP02-PFX or OP03-PFX units are installed.
Cell CV control and the cell voltage in the end condition cannot be used simultaneously. When Cell CV is enabled, the cell voltage in the end condition is disabled.
Because the control speed is slow, the cell cannot be controlled if its voltage changes
rapidly. This setting is applicable to cells whose internal impedance is 500 mΩ or less.

judge Life Enable

Enables life judgment on the discharge. See p. 21.
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Rest Condition
For details on rest conditions, see page 47.

End Condition
See

p. 48

Set the profile end conditions. If OP02-PFXs are installed, you can also set cell voltage and temperature
end conditions. If OP03-PFXs are installed, you can also set cell voltage end conditions.
Cell CV control and the cell voltage in the end condition cannot be used simultaneously.
You must enter the time.
Item

Description

Time

Set the profile’s maximum time. When the total time elapses, the profile is ended.

CV Time

Set the time from when the test enters constant voltage (CV) mode to when the profile
is ended.

Max Temp

When the battery temperature reaches the maximum temperature, the profile is ended.

Curr Capacity

When the integrated current reaches the current capacity, the profile is ended.

Enable It Functionality • It Current
The It current is a current value that you can set as you like for detecting discharge current during constant voltage discharging. When It current is detected, after the It time
elapses, the profile is ended.
• It Time
Set the time that needs to elapse after It current is detected to end the profile.

See

p. 49, p. 51

After you configure the CC-CV discharge settings, configure the temperature chamber and date
record method.
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Configuring the CP Discharge type settings
The CP Discharge, Chamber, Data Record Method tabs are displayed.
Check box items are enabled when you select the check boxes.
The following figure is shown as an example of the Constant Power (CP) discharge operation. The
figure illustrates the transition of constant power discharge -> voltage drop to the cutoff voltage ->
discharge termination -> discharge rest.
Discharge time

Battery voltage

Cutoff voltage

Rest time

Discharge current
Limit current

CP Discharge Setting
Item

Description

Power

Set the discharge power.

Limit Current

Set the upper limit value for the discharge current.
The discharge current increases as the battery voltage drops.

Judge Life Enable

Enables life judgment on the discharge. See p. 21.

Rest Condition
For details on rest conditions, see page 47.
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End Condition
See

p. 48

Set the profile end conditions. If OP02-PFXs are installed, you can also set cell voltage and temperature end conditions. If OP03-PFXs are installed, you can also set cell voltage end conditions.
You must enter the time.

See

p. 49, p. 51

Item

Description

Time

Set the profile’s maximum time. When the total time elapses, the profile is ended.

Cutoff Voltage

When the cutoff voltage is reached during discharge, the profile is ended, even when
the discharge time has not elapsed.

Capa Voltage

When the battery voltage that decreases with discharging goes below the voltage
capacity, discharge capacity integration is stopped.

Max Temp

When the battery temperature reaches the maximum temperature, the profile is ended.

Curr Capacity

When the discharge capacity reaches the specified value, the profile is ended.

After you configure the CP discharge settings, configure the temperature chamber and date record
method.
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Configuring the CP-CV Discharge type settings
The CP-CV Discharge, Chamber, Data Record Method tabs are displayed.
Check box items are enabled when you select the check boxes.
The following figure is shown as an example of the Constant Power and the Constant Voltage (CPCV) discharge operation. The figure illustrates the transition of constant power discharge -> constant voltage discharge -> It time -> discharge rest. (In this example, discharge is complete when It
time is reached.)
Rest time
Discharge time
CV time

Battery voltage
CP operation

CV voltage

It time

Limit Current

Disharge current

It current

CP-CV Discharge Setting
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Item

Description

Power

Set the discharge power.

Limit Current

Set the upper limit value for the discharge current.
The discharge current increases as the battery voltage drops.

CV Voltage

Set the voltage value at which the battery voltage moves to constant voltage (CV)
operation.

Cell CV

The cell with the lowest voltage among the cells in a group is controlled so that it does
not fall below Cell CV. This function is available only when a group is specified when
OP02-PFX or OP03-PFX units are installed.
Cell CV control and the cell voltage in the end condition cannot be used simultaneously. When Cell CV is enabled, the cell voltage in the end condition is disabled.
Because the control speed is slow, the cell cannot be controlled if its voltage changes
rapidly. This setting is applicable to cells whose internal impedance is 500 mΩ or less.

Judge Life Enable

Enables life judgment on the discharge. See p. 21.
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Rest Condition
For details on rest conditions, see page 47.

End Condition
See

p. 48

Set the profile end conditions. If OP02-PFXs are installed, you can also set cell voltage and temperature
end conditions. If OP03-PFXs are installed, you can also set cell voltage end conditions.
Cell CV control and the cell voltage in the end condition cannot be used simultaneously.
You must enter the time.
Item

Description

Time

Set the profile’s maximum time. When the total time elapses, the profile is ended.

CV Time

Set the time from when the test enters constant voltage (CV) mode to when the profile
is ended.

Max Temp

When the battery temperature reaches the maximum temperature, the profile is
ended.

Curr Capacity

When the discharge capacity reaches the specified value, the profile is ended.

Enable It Functionality • It Current
The It current is a current value that you can set as you like for detecting discharge current during constant voltage discharging. When It current is detected, after the It time
elapses, the profile is ended.
• It Time
Set the time that needs to elapse after It current is detected to end the profile.

See

p. 49, p. 51

After you configure the CP-CV discharge settings, configure the temperature chamber and date
record method.
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Configure the pattern details
A pattern is a collection of steps. You can configure up to 10000 steps (up to 100000 steps in a single sequence) in a charge/discharge pattern.
The Pattern, Chamber, Data Record Method tabs are displayed.
Check box items are enabled when you select the check boxes.
Pause time

Total time

Battery voltage

Maximum
voltage
Minimum
voltage

Charge/
discharge current

Loop count

n+1

n

Step current (CC)
0A
Step time
Step number 1
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2 3 4

5

1

2 3 4

5
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Chg/Disch mode, Capacity, RestTemp
Item

Description

Chg/ Disch mode

Select the charge/discharge pattern (CC or CP).
You will not be able to change this setting after you configure the step. Select this first.

Capacity (CC/CP
Ratio)

If you select this check box, the capacity is automatically converted into a current/power
value when profiles are configured in sequences.

RestTemp (LastStep)

The temperature of the last step will be judged. This is valid when the current setting
of the last step is 0 A.

Rest
For details on rest conditions, see page 47.

Editing steps
The tests are executed in order starting from step 1.
Click

to add a step.

To insert a step between two steps, select the step before where you want to insert the step, and
click

.

To delete a step, select the step that you want to delete, and click

.

You can enter steps’ current and power values and times into an Excel sheet, and paste the data to
the Profile Editor.
Click
to paste the data that you copied from Excel. If you copy more than two columns, the
first two columns will be pasted. If you copy more than 10000 rows, the first 10000 rows will be
pasted.
To move a step up, select the step, and click

. To move a step down, select the step, and click

.
Item

Description

Current/ Power

Set the charge current/power and discharge current/power.
To set a discharge current/power, set a negative value.
If you selected Capacity, set the nominal capacitance/power capacitance ratio.

Time

Set the step’s charge/discharge time.

Trigger

If you select this check box, high-speed sampling will start when the step is executed.
You can select this check box in only one step.
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End Condition/Limit
Set the profile end conditions.

Pack
You must enter the total time. Check box items are enabled when you select the check boxes.
Item

Description

Total Time

Set the profile’s maximum execution time. When the total time elapses, the profile
is ended.

Loop Count

Set the number of times to repeat the profile. One iteration of a profile is from
step 1 to the last step. When the specified number of repetitions is complete,
the profile is ended.

Limit/Max Voltage

Select limit voltage or maximum voltage.
If you select limit voltage, the test switches to CV mode when the battery voltage
reaches the limit voltage. The profile is not ended in this case.
If you select maximum voltage, when the battery voltage reaches the maximum
voltage, the profile is ended.

Min Voltage

Set the minimum battery voltage.
When the battery voltage falls below the minimum voltage, the profile is ended.

Upper Limit Current

This is the upper current limit for when you set the charge/discharge pattern to CP.
When the current reaches the specified value, the test switches to CC mode.
The profile is not ended in this case.

Under Limit Current

This is the lower current limit for when you set the charge/discharge pattern to CP.
When the current falls below the specified value, the test switches to CC mode.
The profile is not ended in this case.

Max Temp

Set the maximum battery temperature.
When the battery temperature reaches the specified value, the profile is ended.

Add Current

When the integrated current reaches the specified value, the profile is ended.

Add Power

When the integrated power reaches the specified value, the profile is ended.

Cell CV

This function is available only when a group is specified when OP02-PFX or
OP03-PFX units are installed.
Cell CV control and the cell voltage in the end condition cannot be used simultaneously. When Cell CV is enabled, the cell voltage in the end condition is disabled.
Because the control speed is slow, the cell cannot be controlled if its voltage
changes rapidly. This setting is applicable to cells whose internal impedance is
500 mΩ or less.
• Cell CV Votage(Chg)ss
The cell with the highest voltage among the cells in a group is controlled so
that it does not exceed Cell CV voltage (charge).
• Cell CV Voltage(Dischg)
The cell with the lowest voltage among the cells in a group is controlled so
that it does not fall below Cell CV voltage (discharge).

Cell
See

p. 48

If OP02-PFXs are installed, you can also set cell voltage and temperature end conditions. If OP03-PFXs
are installed, you can also set cell voltage end conditions.
Cell CV control and the cell voltage in the end condition cannot be used simultaneously.

See
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After you configure the pattern, configure the temperature chamber and date record method.
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Configuring the I-V Characteristic type settings
A I-V characteristic pattern is a collection of steps. You can configure up to 10000 steps (up to
100000 steps in a single sequence) in a charge/discharge pattern.
Configure the step and profile end conditions.
Check box items are enabled when you select the check boxes.
The I-V Characteristics, Chamber, Data Record Method tabs are displayed.
Acquired voltage points
Battery voltage

Charge
current

Maximum
voltage
Minimum
voltage
Current (CC)

0A
Discharge
current

Time

・
・
Step number 1 2 3 4 5 6 7 8 9 ・

Discharge I-V characteristic graph
Battery
voltage

Charge I-V characteristic graph
Battery
voltage

Charge current
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Discharge current

I-V characteristic graph
based on acquired
voltage points can be
generated automatically.
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Capacity, Rest Min Temp
Item

Description

Capacity (CC Ratio)

If you select this check box, the capacity is automatically converted into a current value
when profiles are configured in sequences.

Rest Min Temp

If you set the minimum temperature, the test is paused until the battery temperature
of the step whose current is set to 0 A falls below the minimum temperature.

Editing steps
Click

to add a step.

To insert a step between two steps, select the step before where you want to insert the step, and
click

.

To delete a step, select the step that you want to delete, and click
To move a step up, select the step, and click

.

. To move a step down, select the step, and click

.
Item

Description

Step

The step number. The tests are executed in order starting from step 1.

Current

Set the charge/discharge current.
To set a discharge current, set a negative value.
You can change the discharge current to a positive value in Option settings. See: p. 63
If you have selected the capacity check box, set the ratio of current capacity.

Time

Set the maximum charge/discharge duration.

Configuring the steps automatically
Click

to automatically configure steps. You can use this button to create steps that automatically

alternate charging and discharging with current that increases in step increments. If a test is executed
using steps that have been configured automatically, an I-V characteristic graph can be generated
automatically on the Graph Viewer.

Item
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Description

Start Current

Set the current of the first step.

End Current

Set the current of the last step.

Step

Set the number of steps (discharge and charge make up a step).

On Time

Set the charge/discharge time.

Off Time

Set the rest time.

First Step

Select whether to start with charge or discharge.
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End Condition
Set the profile end conditions.

Pack
Item

Description

Max Voltage

When the battery voltage reaches the maximum voltage, the profile is ended.

Min Voltage

When the battery voltage reaches the minimum voltage, the profile is ended.

Max Temp

When the battery temperature reaches the maximum temperature, the profile is ended.

Cell
See

p. 48

If OP02-PFXs are installed, you can also set cell voltage and temperature end conditions. If OP03PFXs are installed, you can also set cell voltage end conditions.

See

p. 49, p. 51

After you configure the I-V characteristic pattern settings, configure the temperature chamber and
date record method.
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Configure the pause settings
This is a profile for pausing tests. You can include this profile to systematically pause tests. When
you resume the test, you can select whether to execute the next profile or a specific profile.
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Setting rest conditions
Set the profile rest conditions.
The figure illustrates an operation of a rest condition (CP discharge).
CP Charge Profile

CC-CV Charge Profile

Next
Profile

Battery
voltage

Charge/
discharge current

Battery
temperature

Minimum
temperature

Minimum
temperature

Pause time

Pause time

Shortened pause time

Extended pause time

Item

Description

Time

Set the rest time.

Min Temp

Set the minimum temperature. Select Extend or Shorten.
• Extend
If you select Extend, when the battery voltage does not fall below the minimum temperature after the rest time elapses, the rest time is extended until it does.
• Shorten
If you select Shorten, when the battery voltage falls below the minimum temperature
before the rest time elapses, the rest time is shortened.
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Setting the end conditions of battery cells
If OP02-PFXs are installed, you can set cell voltages or temperatures as profiles’ end conditions. If
OP03-PFXs are installed, you can set cell voltages as profiles’ end conditions.
Cell CV control and the cell voltage in the end condition cannot be used simultaneously. If Cell CV is
enabled, you cannot set the cell voltage in the end condition. Even if the cell voltage is already set,
when you enable Cell CV, the cell voltage is disabled.
The difference between the maximum and minimum cell voltages for the terminals whose UB
check box is selected is the unbalance voltage. The unbalance margin is detected approximately
0.1 second after the cell voltage measurement completes. If the charge / discharge voltage
fluctuates greatly (the internal voltage of the DUT is high), this function may not operate correctly.
You can use the Copy and Paste buttons to copy and paste the cell contents.
Check box items are enabled when you select the check boxes.
Selecting a terminal, right-clicking, and selecting Copy to all Channel copies the settings of the
selected terminal to all terminals.
Right-clicking and selecting All Check/All UnCheck enables or disables the end conditions (excluding UB) of all terminals. Selecting All Check UB/All UnCheck UB enables or disables the end conditions (only UB) of all terminals.

参照

p. 24

Set the OP02-PFX items on the Exp1 tab. Set the OP03-PFX items on the Exp2 tab. Cells that are not
to be measured cannot be set.

Item

Description

Check box items
(OP02-PFX only)

When you select a check box, the profile is ended when the specified value is
exceeded.

Volt

When the cell voltage exceeds the specified voltage, the profile is ended.

Temp

When the cell temperature exceeds the specified temperature, the profile is
ended.

UB

When the unbalance voltage exceeds the unbalance margin, the profile is
ended.

Check box items
(OP03-PFX only)
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When you select a check box, the profile is ended when the specified value is
exceeded.

Volt

When the cell voltage exceeds the specified voltage, the profile is ended.

UB

When the unbalance voltage exceeds the unbalance margin, the profile is
ended.

Min Volt

Set the minimum cell voltage for ending the profile. This value is valid for discharge, pattern, and I-V characteristic profiles.

Max Volt

Set the maximum cell voltage for ending the profile. This value is valid for
charge, pattern, and I-V characteristic profiles.

Max Temp (OP02-PFX only)

Set the maximum cell temperature for ending the profile.

Unbalance Margin

Set the unbalance margin for ending the profile.
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Configuring temperature chambers
If you are using temperature chambers, you can control them.
Check box items are enabled when you select the check boxes.

Item

Description

Synchronization

Synchronizes the profile start timings of the PFX2500 series that have been
placed in the same temperature chamber.

Repeat

Select this check box to repeat the step. If it is not selected, the temperature of
the last step is maintained.

Wait for a setup of the
1st row

Waits until the temperature of step 1 is stable.
• Judge Temp
Set the allowable range of target temperature.
• Wait time
Even if the temperature chamber reaches the target temperature and humidity,
you must allow some time for the battery in the chamber to reach the temperature. This setting specifies the wait time. If testing is performed in synchronization
with the temperature chambers, the actual charge/discharge starts after the wait
time elapses.
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Editing steps
Click

to add a step.

To insert a step between two steps, select the step before where you want to insert the step, and
click

.

To delete a step, select the step that you want to delete, and click
To move a step up, select the step, and click

.

. To move a step down, select the step, and click

.
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Item

Description

No.

The step number. The tests are executed in order starting from step 1.

Time

Set the step execution time.

Temperature

Specify the temperature setting of the chamber.

Humidity

Specify the humidity setting of the chamber.
Check the control range of the temperature and humidity of the temperature chamber
being used. Depending on the performance of the temperature chamber, some humidity
ranges may not be possible against the specified temperature. In such case, specify -1
and the humidity control will be disabled.
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Data record method
This screen is used to set the recording method of the charge/discharge data file that the Test Executive creates. You can select one or more items. Check box items are enabled when you select the
check boxes.

Data Record Method
Set the method for recording test results.

Item

Description

Delta Time

Set the delta time to time or data values.
If you set the delta time to time, setting a shorter time will cause the amount of
data that will be recorded to increase. When the period of testing time is long, it
is convenient to use the “Auto time” which limits the total volume of the data.
• Fix time
Set the time interval for recording the data. If a short time is specified, the
amount of data that is recorded increases. If the test period is long (several
hours or more), the number of data points becomes greater than 1 000 points.
Use caution when setting the time.
• Auto time
Set the Max data number of data for recording.
Calculated by dividing the maximum test period of each phase (the time when
the test is performed as scheduled without early termination including the
pause section) by the “Max data number.”

Delta Voltage

Data is recorded when the voltage changes by an amount greater than the
specified value.

Delt Current

Data is recorded when the current changes by an amount greater than the
specified value.
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Fast Sampling
Select this check box to enable high-speed sampling. High-speed sampling will make graph drawing take a long time and will consume more hard disk space. If you do not need high-speed sampling, do not select this check box.

Item

Description

Delay time

Set the delay for starting high-speed sampling. If a trigger voltage is specified, the
delay is from when the trigger voltage is exceeded until high-speed sampling
starts. If the profile type is pattern and a step trigger is specified, the delay is from
when the specified step is reached until high-speed sampling starts. For other
cases, the delay is from when the profile starts until high-speed sampling starts.
The selectable range is 0 s to 999 s. If the profile type is pattern, the selectable
range is from -1 s.

Trigger Voltage

Select the voltage detection method (Rising or Falling).
• Trigger Voltage
Set the voltage to start high-speed sampling.

Sampling time

Set the sampling time interval (1 ms/ 10 ms/ 100 ms).
• Meas time
Set the duration to measure in high-speed sampling mode.

SOC (State of Charge)
Set the SOC reference. If you do not set it, the previous SOC value is used.
This is useful for capacitance measurement tests.
The SOC indication is determined by the following equation.
SOC indication [%] = SOC at charge/discharge start time [%] +

Charge/discharge current capacity
Reference current capacity

× 100 [%]

SOC at charge/discharge start time can be set to the previous result or a specific value.
The reference current capacity can be set to the nominal value or a measured value.

52

Item

Description

Start

Set a specific value.

End

Set a specific value.
The default reference current capacity is the nominal current capacity. If you
select the “SOC is based” check box, the SOC for subsequent tests will be calculated using this test profile’s test result.
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Saving a profile template
When you finish the profile template settings, enter the settings under Name Setting, and save the
file. You can enter up to 48 characters for Name Setting.

Item

Description

Profile Name

Enter the name of the file. Be sure to enter the name.

Memo

Enter memos and comments as you like.

Operator

Enter the operator name.

Category 1

Enter a category (keyword) as you like. You can use this as a filter for searching for
graphs to draw in the Graph Viewer.

Category 2

Enter a category (keyword) as you like. You can use this as a filter for searching for
graphs to draw in the Graph Viewer.

Date of Issue

Displays the date when the profile template was created. You cannot enter this information.

Date of Edit

Displays the date when the profile template was last updated. You cannot enter this
information.

When you have entered the necessary information, click Save Database to save the profile template
in the BPChecker3000 profile template database.
The profile template database may be corrupted if the Test Condition Editor terminates abnormally.
We recommend that you regularly back up the database.
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Changing and deleting a profile template
You can change a saved profile template or use it to create a new template.
The saved profile templates are displayed in the Profile Template List on the New or Edit Profile
Template tab.

Changing a profile template

1

From the the profile templete List, select the profile template that you want to
change.
You can use filters to narrow down the profile templates that are shown in the list. The
contents of the selected profile template are displayed under Profile Contents.

2
3
4
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Click Edit.
The Profile Editor opens.

Change the settings.
Click Save Database to save the template.
The Profile Editor closes, and the profile template is overwritten.
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Creating a new profile template using an existing profile template

1

From the Profile Template List, select the profile template that you want to
change.
You can use filters to narrow down the profile templates that are shown in the list. The
contents of the selected profile template are displayed under Profile Contents.

2
3
4
5

Click Edit.
The Profile Editor opens.

Change the settings.
Change the Profile Name.
The Profile Name setting is used as name for saving the profile template in the database. If
you do not change the Profile Name or use an existing Profile Name, the profile will be
overwritten.

Click Save Database to save the template.
The Profile Editor closes, and the new profile template is saved.

Deleting a profile template

1

From the Profile Template List, select the profile template that you want to
delete.
You can use filters to narrow down the profile templates that are shown in the list. The
contents of the selected profile template are displayed under Profile Contents.

2
3

Right-click, and select Delete.
Click OK.
The selected profile template is deleted from the database.
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Backing up the profile template database
Profile templates that you create are saved in the BPChecker3000 database.
The profile template database may be corrupted if the Test Condition Editor terminates abnormally.
BPChecker3000 allows you to create back up of the database. For protecting your data, regularly
back up the database.
This is also useful when you are using a different PC to execute tests or if you need change the PC
that will run BPChecker3000.
On the Tool menu, click Utility and then Validate to check whether the profile template database is
not corrupt.

Backing up the profile template database

1
2

On the Tool menu, click Utility and then Backup.
Enter a file name, and save a back up of the profile template database.

Recalling a backup file

1
2
3
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On the Tool menu, click Utility and then Restore.
Select a backup file that you have saved before.
Restart the Test Condition Editor.
The database is restored to the saved information.
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Configuring Sequences
After you have completed configuring general settings and creating profile templates, configure
sequences.
You can configure 256 profiles in a single sequence.
You can configure 256 sequences in a project.

Entering settings on the Sequence tab
Sequences are a collection of existing profiles. The Sequence tab consists of three panes.
Sequence pane

Sequence configuration pane

Profile pane

Pane

Description

Sequence configuration

Displays a project’s sequence configuration.

Sequence

Displays sequence information.
Sequences displayed in the sequence pane are executed in order from the top.
If you select a sequence in this pane, the profiles in the sequence are displayed in the
profile pane.
You can use this pane to add and delete sequences from the project.
Set the end conditions of sequences and other settings.

Profile

Displays the profiles in the sequence that is selected in the sequence pane.
You can use this pane to add and delete profiles from the sequence.
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Configuring Sequences

Sequence configuration workflow
The Test Executive executes charge/discharge test sequences displayed in the sequence pane in
order from the top sequence.

1
2
3
4

In the sequence pane, add a sequence.
In the profile pane, add profiles to the sequence.
In the sequence pane, set the number of repetitions, end conditions, etc.
Repeat step 1 to step 3 to configure all necessary sequences.
When you finish configuring sequences, execute charge/discharge tests using the Test
Executive.

Configuring sequences

In the sequence pane, click

to add a new sequence to the project.

To insert a sequence between two sequences, select the sequence before where you want to insert
the sequence, and click

.

To delete a sequence, select the sequence that you want to delete, and click
To move a sequence up, select the sequence, and click
sequence, and click

.

. To move a sequence down, select the

.

Next, add profiles to the sequences that you have created.

58

BPChecker3000 Test Condition Editor

Configuring Sequences

Adding profiles to sequences

Adding a profile

1
2

In the sequence pane, select the sequence that you want to add profiles to.
In the profile pane, click
to open the profile template list (the list of profile templates in the database).
You can use filters to narrow down the profile templates that are shown in the list.

3

From the list, select a profile template that you want to add to the sequence.

4

Click Add to Seq. to add the profile to the sequence.

The details of the selected profile template are displayed under Contents.

The selected profile is added to the profile pane.
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Configuring Sequences

5

To add more profiles to the sequence, repeat step 3 and step 4.

6

When you finish adding all the necessary profiles to the sequence, click Close.

The selected profile is added to the profile pane.

The profile template list closes.

Changing the settings of a profile that has been added to a sequence
You can change the settings of a profile that has been added to a sequence. Changing the profile
that has been added to a sequence will not change the settings of the profile template in the profile
template database. If you add the same profile after changing the settings, the profile with the original settings will be added.
If you change a profile that has been added to a sequence, an asterisk is appended to the Profile
Name in the profile pane. This asterisk indicates that the profile settings are different from those of
the profile template in the database.

1
2
3
4
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In the profile pane, select the profile that you want to change.
Click

.

The Profile Editor opens. The Name Setting area will be unavailable.

Change the settings.
Click Reflect Sequence.
The profile in the sequence will be changed. An asterisk is appended to the Profile Name.

BPChecker3000 Test Condition Editor

Configuring Sequences

Changing the profile configuration and deleting profiles
To insert a profile between two profiles, select the profile before where you want to insert the profile, and click

.

To delete a profile, select the profile that you want to delete, and click
To move a profile up, select the profile, and click
and click

.

. To move a profile down, select the profile,

.

Setting sequence settings
After adding profiles, set sequence end conditions and other settings.
In the sequence pane, select the sequence that you want to configure.

Item

Description

Seq Name

Enter the sequence name.

Repeat

A sequence execution includes the execution of all the charge/discharge tests defined
in the profiles starting with the top profile. When the test of the last profile is complete,
one iteration of the sequence is complete.
Set how many times to repeat the sequence.

Total Time

Set the total time for executing the sequence.
If more than the total time has elapsed when a profile is complete, the sequence is
ended, and the next sequence is executed.

Chain

Select whether to start the next sequence or end the test.
Select Next to execute the next sequence.
Select End to end the test, without executing the next sequence.

When you finish configuring all sequence settings, save the project.
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Setting Links and Jumps
You can use test results as conditions for the following test (links) and use factors that cause the
profile to stop to branch the sequence (jumps).
The Link Jump tab displays sequence settings graphically. You can use this graphical interface to set
links and jumps. Use right-clicking to set links and jumps.
For details on settings, see tutorial (Select Windows All Programs, Kikusui BPChecker3000, and Manual).
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Other Settings
You can set current polarity, power capa unit, volume unit, and mass unit.
On the Tool menu, click Option.

Item

Description

Current Polarity

You can select whether to make charging positive or discharging positive.
By default, charging is positive and discharging negative. If you entered the pattern or
I-V characteristic profile with charging on the negative side, you can use the data as-is
by selecting Chg - DisChg +.
In the charge/discharge profile, the graph display is inverted.
This is synchronized with the current polarity setting of Graph Viewer.

Power Capa Unit

Select the power capacitance unit (Wh or kWh) to display in Test Condition Editor.

Voltage Unt

Select the volume unit (l or ml) to display in Test Condition Editor.

Mass Unit

Select the weight unit (g or kg) to display in Test Condition Editor.
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Saving Projects
When you finish configuring all sequence settings, save the project.
To save a new project or overwrite a recalled project, on the File menu, click Save Project, or click
Save. Enter the file name and save.
To save a recalled project with a different name, on the File menu, click Save Project As. Enter the file
name and save.
After you save the project, you can start charge/discharge tests using the Test Executive.
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Menu Reference
Menu
File

Description
New Project

Create a new project.

Open Project

Open a saved project.

Save Project

Overwrite a project.
Save a project with a specific file name.

Tool

Help

Resent Project File

Open a recent project file.

Exit

Closes the Test Condition Editor.

Utility

Backup

Back up the profile template database.

Restore

Restore the profile template database.

Validate

Checks whether the profile template database is corrupt.

Option

Set the current polarity, power capa unit, volume unit, and mass unit.

About

Displays Test Condition Editor information.

Help

Displays a help file.
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Menu Reference
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Test Executive
This operation guide explains how to use the Test Executive to run tests.
The Test Executive is a program that executes charge/discharge tests in accordance with the test conditions that you created using the Test Condition Editor.
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Starting the Test Executive
Before starting the Test Executive, configure the hardware using the IO Config.

When synchronizing with the temperature chamber
Turn on all RS485-to-USB adapters, and temperature chambers before starting the Test Executive.

Starting the Test Executive
To start the Test Executive, on the taskbar, click Start, All Programs, Kikusui BPChecker3000, and Test
Executive.
Before the Test Executive starts, a system and temperature chamber configuration window opens.
You can also configure the settings that you set in this window while the Text Executive is running.
To do so, on the select menu, click I/O Configuration.
Click OK to start the Test Executive.

System
The present connection status appears.
Set the range.
If the status is not displayed correctly, the connection may be incorrect, or there may be overlapping
channels. Connect the PFX2512s correctly, and click Connect. Check that all channels are displayed.
You can also type the IP address. After typing the IP address, click Connect.
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Chamber
The VISA, driver, and maximum chamber settings are displayed (the IO Config is used to configure
these settings).

Chamber Temperature
The temperature chamber temperatures are set automatically in accordance with the test conditions. On the Chamber tab, you can manually set the temperature and humidity.
If you enter a temperature chamber temperature, you will be able to manually specify the temperature at the start of a test or while a test is paused.
When you finish configuring the settings, click OK.
Item

BPChecker3000 Test Executive

Description

Chamber

Select the temperature chamber that you want to configure.

Temp

Set the temperature chamber temperature.

Humidity

Set the temperature chamber humidity.

Last Set

If you select this check box, the temperature and humidity settings that are applied
at the end of the test or when the test is paused are enabled.
Set the last temperature and humidity.
• Temp
Set the temperature for when all the tests are finished.
• Humidity
Set the humidity for when all the tests are finished.
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Parts of the Screen
The Test Executive consists of three panes.
Channel pane

Setup display pane
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Charge/discharge graph pane

Pane

Description

Channel pane

Displays all channels and the execution status.

Setup display pane

Displays the settings that you have configured using the Test Condition Editor.

Charge/discharge graph pane

Displays graphs of measured current and voltage.
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Starting Tests
Configuring hardware protection

The PFX2500 series is equipped with circuitry for protecting batteries from overcharging and overdischarging. These protection functions are called HOVP (hardware OVP) and HUVP (hardware UVP)
and are separate from the protection settings (SOVP and SUVP) on BPChecker3000.
A comparator is used at the detection section and the circuit is independent from the internal
microcomputer control. The detecting speed is 10 ms (TYP value).

1
2
3

On the Test menu, click HW Protect.
Select the channel that want to set HOVP or HUVP on.
Click Set.
The input dialog box appears.

4

Set the HOVP, HUVP, and Volt Range.

5

Click OK.

6

Select the check boxes of the channels that you want to set HOVP/HUVP.

7

Click Cancel to close the Hardware Protect setup window.

To cancel, click Close.

The internal variable resistors are automatically adjusted.
The HOVP and HUVP settings in the Hardware Protect dialog box display the PFX2500
series hardware settings. Check that the settings are correct.

HOVP/HUVP is enabled.

HOVP and HUVP protect the DUT (battery) from overcharging and overdischarging at all times,
even when tests are not being executed with BPChecker3000. Set a HOVP that is higher than S_OVP
to prevent erroneous operation due to noise and by taking the detection accuracy (±300 mV) into
consideration. Set a HUVP that is lower than S_UVP.
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Starting Tests

Assigning test conditions
Before starting a test, assign test conditions. Click
. Or on the Test menu, click Start Setting
to open the Test Start Setting dialog box. Test conditions are assigned at the channel level. You can
execute completely different tests on each channel.

If you are not using temperature chambers

1
2
3

Select the check boxes for channels that you want to execute tests.
Click
of a channel that you want to assign test conditions to, and select a
test condition file (.BPCT3 extension) that you saved with the Test Condition
Editor.
Check that Chamber Name is set to None.
If not, set it to None. You can now start the test.

If you are using temperature chambers
To use temperature chambers, specify the Chamber Name.
If you are using a temperature chamber to test multiple channels, select which channel’s conditions
to use to control the chamber by raising a flag in the Chamber Cond column.

1
2

From the list, select the Chamber Name for testing the channel.
Click the channel whose temperature chamber conditions will be used, and
click Condition.
A flag is raised in the Chamber Cond cell. You can now start the test.

See
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You can change the temperature chamber conditions during a test.
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Starting Tests

Starting a test
When you finish assigning test conditions, Test Start becomes available. Click it to start the test.

See

p. 78

When all the scheduled tests in the project are complete, the test is complete.
You can pause and abort a test.

Changing temperature chamber conditions
If you are using temperature chambers, you can change the channel whose temperature chamber
conditions are being used. When the test of the channel whose temperature chamber conditions
are being used finishes before other channels, change the assigned channel.

1

2
3
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On the Test menu, click Chamber.
The ChangeCondition dialog box opens.

Select the channel for the temperature chamber that you want to specify.
Click OK.
The temperature chamber condition will be changed.
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Screen display
Channel pane

Setup display pane

Charge/discharge graph pane

Channel pane
Displays all channels and the execution status. If multiple channels are being tested, the information
of the channel selected in the channel pane is displayed in the setup display pane and charge/discharge graph pane.
Displayed item

Description

Ch

Displays the channel number.

Status

Displays the channel status.

SOC

Displays the SOC status.

Operation

Displays the present electrical operation (charging, etc.)

Voltage

Displays the present voltage measurement.

Max Cell Voltage

Displays the maximum voltage and the cell with the maximum voltage among
the cells in the group.1

Min Cell Voltage

Displays the minimum voltage and the cell with the minimum voltage among
the cells in the group.1

Current

Displays the present current measurement.

Power

Displays the present power value.

Capacity

Displays the present current capacity measurement.

SOC Base

Displays the SOC reference capacity.

Electric Enagy

Displays the present electric energy measurement.

Temperature

Displays the present DUT (battery) temperature measurement.

Elapsed Time

Displays the elapsed time since the profile started. The elapsed time includes
the pauses. The display is not reset when test switches to pause mode. This is
not the total elapsed time since the start of the test.

Cycle Count

Displays the number of executed profiles (including profiles in execution).

Information

Displays a log of test execution. Displays maintenance information.

1

1: OP02-PFX Slot number in which
2: OP03-PFX OP02-PFX/OP3-PFX is inserted

Term No.
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Voltage value
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Screen display

Selecting a channel
Click a channel that you want to display. The selected channel turns yellow, and the channel settings
are displayed in the setup display pane and charge/discharge graph pane.

Setup display pane
Displays the test settings of the channel that is selected in the Channel Pane. This pane consists of
four tabs.
Tab

Description

General

Displays project settings.

Condition

Displays profile settings. Right-click to view settings of other profiles.

Sequence

Displays sequence configuration as well as the sequence and profile that are being
executed.

Link Jump

Displays link and jump configurations. Displays the profile that is being executed
with a red frame.

Charge/discharge graph pane
The charge/discharge graph pane displays graphs of measured current and voltage.
Depending on the test progress, the graph is simplified through data decimation. Use the Graph
Viewer to view detailed graphs.
Voltage and current are displayed. This pane consists of eight tabs.
See

p. 83

To save graphs, on the Edit menu, click Save Graph.
To configure drawing style settings such as the graph’s color, line type, and scale, on the Tool menu,
click Option, and then click the Graph tab.
Tab

Description

Prof.1

Displays a real-time graph of a single profile. You can select scroll display.

Seq

Displays a real-time graph of a sequence. It does not include repetitions. If the
number of profiles is one, this graph will be the same as the real-time graph of
the profile.

Seq.All

Displays a real-time graph of all sequences including repetitions. If the number
of profile loops is one, this graph will be the same as the sequence real-time
graph.

All

Displays a real-time graph of the entire project.

Result

Displays a summary of charge and discharge results.1

Cell Monitor (Exp1) Displays monitored cell voltages and cell temperatures of OP02-PFX
Cell Monitor (Exp2) Displays monitored cell voltages of OP03-PFX
Chamber Monitor
1
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Displays temperature chamber states.

If a test ends with I-V characteristics as the last profile, “Pattern Repeat Count” may appear.
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Screen display

Chamber Monitor
The Chamber Monitor tab displays temperature chamber states.

Item

Description

Chamber Name

Displays the temperature chamber name.

InChannel

Displays the channel number.

State

Displays the temperature chamber state.
IDLE

A state in which the temperature chamber has been recognized. The chamber
is in this state also during charging and discharging and during a pause.

TEMP SETTING

A state from when the temperature is set until the monitored chamber temperature enters within the specified margin. The time it takes for the monitored chamber temperature to enter within the specified margin depends
on the chamber performance.

SYNC

A state in which the chamber temperature is stable at the specified temperature but the DUT has not yet acclimatized to the temperature. After the
wait time elapses, the chamber will transition to the IDLE state.

Chamber Connec- A state in which the Test Executive cannot communicate with the temperation Error
ture chamber.
Test/ Step x
WaitTime
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Displays the step number in execution.
When the chamber state is SYNC, a countdown starts from the specified
wait time.

Temp

Displays the monitored chamber temperature and the specified temperature.

Humi

Displays the monitored chamber humidity and the specified humidity.
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Stopping Tests and Clearing Alarms
Stopping a test
You can stop a test before all the scheduled tests in the project are complete.
There a three ways to stop a test: stop, pause, or emergency stop.
Item

Description

Stop

Stops the test after displaying a stop confirmation dialog box. You can select
the channels to stop and the timing.

Pause

Pauses the test. You can resume from the specified profile.

Emergency Stop

Immediately stops all charge and discharge operations of all channels.

Stopping a test
To stop a test in execution, click

. Or on the Test menu, click Stop.

A Stop window appears. Select which channels to stop and when to stop.

1
2
3
4
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Stop Condition

Description

StopNow

Immediately stop the test.

ProfileEnd

Stop the test after the pforile is complete.

Select the check boxes of the channels that you want to stop.
Select the Stop Condition for the channels.
Click Test Stop.
The test stops at the specified time.

Click Cancel to close the Stop window.
The current status is displayed under Information in the channel pane.
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Pausing a test
To pause a test in execution, click

1
2
3
4
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. Or on the Test menu, click Pause.

Pause Condition

Description

Pause Now

Immediately pauses the test.

Pause

Pauses the test after the profile is complete.

PauseCancel

Cancels a pause.

Select the check boxes of the channels that you want to pause.
Select the Pause Condition for the channels.
Click Pause.
The test pauses at the specified time.

Click Cancel to close the Pause window.
The current status is displayed under Information in the channel pane.
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Resuming a test
To resume tests, click

. Or on the Test menu, click Continue.

You can set resume conditions. You cannot resume a test from the middle of a profile.

Continue Mode

1
2
3
4

Description

Next Profile

Resumes from the next profile.

FromSeqNo

Resumes from the specified profile number, sequence number, and repeat count.

Stop

Aborts tests.

Select the check boxes of the channels that you want to resume.
Select the Continue Mode of the channel.
Click Continue.
The test resumes at the specified time.

Click Cancel to close the Continue window.

Immediately stopping a test (emergency stop)
In an emergency, you can immediately stop all charge and discharge operations. Click
. Or on the Test menu, click Emergency Stop. The charge and discharge operations of
all channels are stopped without a confirmation screen.
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Stopping Tests and Clearing Alarms

Clearing alarms
When alarms occur during a test, relevant channels are automatically stopped on the charge/discharge power supply side.
You can view the channels on which alarms occurred in the channel pane.
Click

to clear the alarms of all channels. Or on the Test menu, click Alarm Clear.

If you do not eliminate the root causes of the alarms, the alarms will reoccur when you restart the
test.

Disconnecting the communication of a specific channel
You can disconnect the communication of a specific channel. This is useful if you want to disconnect the LAN connection to a charge/discharge unit because of a failure or other reason when a test
is being executed on multiple channels.

1
2

In the channel pane, select the channel you want to disconnect.
Right-click and click Unp

The communication to the selected channel will be disconnected. IOErr will not occur if you remove
the LAN connection from a disconnected channel. Channels being tested cannot be disconnected.
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Data Files That Are Saved
BPChecker3000 creates a folder with the same name as the test condition file in the same folder as
the test condition file. In this folder, BPChecker3000 creates CHxx_date folders for each channel on
which a test was executed. BPChecker3000 creates files containing test results after a test is completed.
• C/D graph data file
(CYCLEx_CHG.csv, CYCLEx_DIS.csv, CYCLEx_PAT.csv, CYCLEx_I_V.csv)
• C/D graph text high-speed sampling data
(CYCLEx_CHGhs.csv, CYCLEx_DIShs.csv, CYCLEx_PAThs.csv, CYCLEx_I_Vhs.csv)
• Life data (LIFE.csv)
• Graph Viewer data file (extension: BPCG3, BPCL3, index, PROALL, SEQALL), system administration file (extension: mdb)

参照
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On the Save Text tab under Tool > Option, you can select whether to generate test result text files
and Graph Viewer data files.
If you clear the “Save the test result to the text file” check box, text files will not be generated.
If you clear the “Save the data for Graph Viewer” check box, neither Graph Viewer files nor system
administration files will be generated. You will not be able to graph test data on Graph Viewer, but
the load on the PC will be reduced. This is useful when you carry out long tests.
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Other Settings
Option settings
Set the graph color, how the temperature chambers respond when alarms occur, text save options,
and maximum channel number. On the Tool menu, click Option.

Graph tab
Set the graph items to display and drawing style. The settings apply to all channels.
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Other Settings

Warning tab
When an alarm occurs in a test that uses temperature chambers, set how the other channels in the
same chamber will respond to the alarm.

Alm Sync

Description

Pause

When an alarm occurs, the tests of other channels in the same temperature chamber will stop immediately.

ALM

When an alarm occurs, the tests of other channels in the same temperature chamber will stop after finishing the profile in execution.

Continue

When an alarm occurs, the tests of other channels in the same temperature chamber will continue with their tests. When the channel in which the alarm occurred is
assigned to be the priority channel of a chamber, the priority must be changed.

Save Text tab
Set the options for saving C/D graph data to text files.

You cannot clear both of these
check boxes simultaneously.

Item

Description

Save the data for Graph Viewer

Data files that allow test results to be viewed on Graph Viewer are
output.

Save the test result to the text file

Test result text files (CSV format) are output.

Setting

Comma delimited

Comma-separated text data is saved.

tab delimited

Tab-separated text data is saved.

file extension

Specify the extension of test result text data (CSV format).

Output in the old format A text file is saved in the same format as BPChecker Ver.1.x.
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Other Settings

Monitor tab
Set the items to display in the channel pane. You can set the font size.

Other tab
Select a channel in the channel pane, and set the response when the channel grid is doubleclicked.
The Max Ch setting is a custom order feature. It is not available with this product.
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Other Settings

Checking the PFX2500 series firmware version
Right-click on the channel pane and click Information to view the firmware versions of the PFX2500
series and option boards.
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Recovery after Power Failures
Describes the behavior of the charge/discharge test system when a power failure occurs while
using the system.

When a Power Failure Occurs on the Charge/Discharge Unit
If a power failure occurs on the charge/discharge unit while the host PC is running normally, the
behavior of the Test Executive varies depending on the operation status of the chsarge/discharge
unit. The operation status of the charge/discharge unit is indicated on the Channel Pane.

When a power failure occurs on a charge/discharge unit
If a power failure occurs on a channel, the Test Executive will detect a communication error within
approximately 10 s. The Status corresponding to the channel changes to an IOErr. (This is the same
if the power failure recovers within 10 s.)

1

To reconnect to the PFX2500 series, from the Tool menu, select I/O configuration.
The I/O configuration window appears.

2
3
4

Click Connect.
Check that the PFX2500 that you want to test is displayed, and click OK.
The system and temperature chamber configuration window closes.

To resume the test by specifying a profile, check the sequence number, profile
number, and repeat count of the sequence that was aborted due to a power
failure.
You can check them on the Sequence tab of the setup display pane.
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Recovery after Power Failures

5

To redo the test from the beginning, click Start Setting. To re-execute the test
from the beginning of the profile that was being executed when a power
failure was detected, from the Tool menu, click Recovery.
When redoing the test from the beginning, this completes the recovery procedure. The
procedure from here is for the case when you want to restart the test from a profile in the
middle of the test.
From the Tool menu, select Recovery to display a FormRecover window.

6
7
8
9

Select the check boxes of the channels that you want to resume tests.
Click
of a channel that you want to assign test conditions to, and view the
test result file (BPCL3 extension) that was aborted due to the power failure.
If a temperature chamber was used, select the chamber to use.
Click Recovery.
A Continue window appears.

10 Select the check boxes of the channels that you want to resume tests.
the resume conditions.
11 Select
If you select FromSeqNo, specify the sequence number, profile number, and repeat count
of the sequence that you want resume.

Continue.
12 Click
The test is resumed according to the selected resume conditions.
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Recovery after Power Failures

When a power failure occurs on the host PC side or on all devices
If a power failure occurs on the host PC side, a communication error will occur (it will take several
tens of seconds for this detection), and the test will stop.
When a power failure occurs on all devices, all charge/discharge units enter the idle state immediately after the power supply hardware recovers.

1
2

3
4
5
6

7
8

9
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Restart the charge/discharge units.
Restart the PC, and start Test Executive.
A FormRecover window appears.

Select the check boxes of the channels that you want to resume tests.
Click
of a channel that you want to assign test conditions to, and view the
test result file (BPCL3 extension) that was aborted due to the power failure.
If a temperature chamber was used, select the chamber to use.
Click Recovery.
A Continue window appears.

Select the check boxes of the channels that you want to resume tests.
Select the resume conditions.
If you select FromSeqNo, specify the sequence number, profile number, and repeat count
of the sequence that you want resume.
If you do not know the sequence number, profile number, or repeat count of the sequence
that was aborted by the power failure, click Cancel, and check them on the Sequence tab
in the setup display pane. From the Test menu, select Continue to display a Continue window.

Click Continue.
The test is resumed according to the selected resume conditions.
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Menu References
Menu

Description

File

Exit

Closes the Test Executive.

Edit

Save Graph

Saves graphs to files.

Test

Start Setting

Starts tests.

Stop

Stops tests.

Emergency Stop

Immediately stops tests (emergency stop).

Alarm Clear

Clears alarms.

Pause

Pauses tests.

Continue

Resumes paused tests.

Tool

Help

Chamber

Change the chamber priority channel.

HW Protect

Configure hardware protection.

Option

Set options.

Recovery

Recovers from a power failure.

I/O Configuration

Configure system and temperature chamber settings.

CAN configuration

Not available on this product (custom order feature).

About SD007-BPC Test Executive

Displays the Test Executive information.

Help

Displays a help file.
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Menu References
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Graph Viewer
The Graph Viewer is used to display or print graphs of test data that has been generated by the Test
Executive. In addition to test data graphs, test data values, energy and other computed values
determined from test data, and test conditions can be displayed allowing you to analyze the data
comprehensively.
The Graph Viewer can display multiple graphs overlapped.
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Starting the Graph Viewer
To start the Graph Viewer, on the taskbar, click Start, All Programs, Kikusui BPChecker3000, and
Graph Viewer.
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Displaying Graphs
To display graphs, on the File menu, click Open. Then, select a life file (.BPCL3 extension) that the
Test Executive has generated.
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Parts of the Screen
The Graph Viewer consists of Three panes.
Overview pane

Graph
pane

Project
pane

Pane

Description

Overview pane

Displays the entire test results on a graph.

Project pane

Displays the test conditions from the loaded test result file on three tabs
(Sequence, General, Condition).

Graph pane

Displays the test results from the loaded test result file on three tabs
(Profile, I-V, Life).

You can move the cursor over the boundaries of the panes (the cursor changes to
the pane sizes.
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) to change
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Parts of the Screen

Overview pane

Sequence

I-V characteristic profile

Repetition1

Repetition2

Repetition3

PF1

PF1

PF1

PF2

PF2

PF2

Repetition separator
Profile (PF) separator
Sequence separator

Conﬁgure overview pane settings.
Zoom Out

Zoom

Zoom In

Previous Sequence

Next Sequence

Previous Repeat
Previous Profile

Next Repeat

Display 2 Profile

Next Profile

Conﬁgure graph pane settings.
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Overview Pane Icon

Description

Zoom In

Zooms in on the overview pane.

Zoom Out

Zooms out of the overview pane.

Previous Sequence

Displays the first profile of the previous sequence in the selected profile on the
Profile tab of the graph pane.

Previous Repeat

Displays the last profile of the previous repetition in the selected profile on the
Profile tab of the graph pane.

Previous Profile

Displays the profile previous to the selected profile on the Profile tab of the
graph pane.

Next Profile

Displays the profile subsequent to the selected profile on the Profile tab of the
graph pane.

Next Repeat

Displays the first profile of the next repetition in the selected profile on the
Profile tab of the graph pane.

Next Sequence

Displays the first profile of the next sequence in the selected profile on the
Profile tab of the graph pane.

Zoom

Displays the overview pane.
• Project
Displays the entire project.
• Sequence
Displays the entire sequence.
• Repeat
Displays specific repetitions of a sequence.

Display 2 Profile

Displays the selected profile and the next profile on the Profile tab of the graph
pane.
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Parts of the Screen

Click
icons to select the profile graph to display on the Profile tab of the graph
pane. When you click these icons, a graph is displayed in the thumbnail area on the Sequence tab of
the project pane. The process to display in the graph pane begins 3 seconds after these icons are
clicked. You can check the time until the display processing will begin with the progress bar in the
lower left of the window.

You can also double-click the profile that you want to display the entire graph of to display the
profile graph. The process to display in the graph pane begins 3 seconds after double-clicking.
It may take some time to display the graph in the graph pane. We recommend that you check the
thumbnail graph first and then display it in the graph pane.
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Parts of the Screen

Project Pane
The project pane displays the test conditions from the loaded test result file. This pane consists of
three tabs.

BPChecker3000 Graph Viewer

Tab

Description

Sequence

Displays the structure of the test conditions in a tree.
Displays the thumbnail of the selected profile.

General

Displays the settings of the entire project.

Condition

Displays the test settings of the profile shown in the graph pane.
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Parts of the Screen

Sequence Tab
On the sequence tab, you can click a profile to display a graph in the thumbnail area. Doubleclicking it displays the selected profile in the graph area. The process to display in the graph pane
begins 3 seconds after double-clicking.
It may take some time to display the test results in the graph pane. We recommend that you check
the thumbnail graph first and then display it in the graph pane.

Exporting test data to a csv file
You can export text data (csv extension) of tests for each project, each sequence, or each profile.

1
2
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Select the project, sequence, or profile that you want to export.
Right-click, and select Export.
The test data will be exported to a csv file.
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Parts of the Screen

Graph Pane
The graph pane consists of a graph area and text area. It displays the test results in a graph and as
text.
The graph area consists of three tabs. The text area displays different tabs depending on the tab
selected in the graph area.

Graph
Area

Text
Area
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Graph Area Tab

Description

Tabs displayed in the text area

Profile

Displays the test result graph of the profile.
See: p. 100

Result
Standard measurement data
High-speed sampling
Overlap

I-V

Displays the I-V characteristic graph.
See: p. 104

I-V characteristic data
I-V characteristic overlap

Life

Displays the life graph.
See: p. 109

Life data
Life data overlap
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Displaying Profile Graphs
The profile graph is displayed on the profile tab in the graph pane. You can set up to four items on
the Y axis.
Select the profile that you want to display the graph of from the overview pane, sequence tab of
the project pane, or the result tab of the graph pane.
It may take some time to display the profile graph in the graph pane. If you are selecting the profile
in the overview pane or project pane, we recommend that you check the thumbnail graph first and
then display it in the graph pane. If you are selecting from the graph pane, we recommend that you
check the test result text of the profile first and then display it in the graph pane.
Profile displayed in the
Profile pane

Profile
displayed in the
Profile pane
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Displaying Profile Graphs

Graph Area
Zoom Out
Zoom Im

Y1 axis setting

Clear

X

Y2 axis setting
Y2

Y1

Y4 axis setting

Y3 axis setting
Y4

Y3

Sampling point
Cursor A

Cursor B

Move Y1 axis

Move Y2 axis

Move Y4 axis

Move Y3 axis

Item

Description

X

Selects the item (Time, Capacity Ah, or Capacity Wh) to display on the Xaxis.

Zoom In
Zoom Out

Zooms in or out of the area between cursors A and B.

Clear

Clears the cursor history.

Y1
Y2
Y3
Y4

Selects the item (None, Voltage, Current, Power, Capacity Ah, Capacity Wh,
Temperature, Chamber Temperature, SOC(MEAS), SOC(BMS), Cell Voltage,
or Cell Temperature) to display on the Y-axis.

Y axis setting
Y2 axis setting
Y3 axis setting
Y4 axis setting

Expands or reduces the Y-axis
This appears when the item assigned to the Y-axis is not None.

Move Y1 axis
Move Y2 axis
Move Y3 axis
Move Y4 axis

Drag to move the data line up and down.
Right-drag to move the Y-axis zoom point (center of Y-axis zooming) up
and down.
This appears when the item assigned to the Y-axis is not None.

Cursor A
Cursor B

Drag to set the X-axis range to zoom.

Sampling point

Displays standard measurement data points as dots.

Y-axis graph information
Holding down the left mouse button on the data line displays the information.

BPChecker3000 Graph Viewer
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Displaying Profile Graphs

Expanding and reducing the display
Expanding and reducing the X-axis (Cursors A and B)
You can expand the profile pane by specifying a range. The previous expansion setting is retained,
so you can easily return to the previous display.
You can move cursors A and B by dragging. Cursors A and B snap to the standard measurement
data. You can only select points in the standard measurement data.
Clicking
direction.

(Zoom In) displays the area specified by cursors A and B fully in the horizontal

Clicking
(Zoom Out) reverts to the previous display before zooming. If there is no history, the
area is reduced to the optimal size.
Right-clicking a point on the standard measurement data tab of the text area moves the cursors A
and B (Move the cursor A here, Move the cursor B here) to the selected point. Moreover, rightclicking in the standard measurement data tab displays the text data of the present cursors A and B
(Go to cursor A, Go to cursor B).
The zoom history can be cleared by clicking
See

p. 120

(clear cursor history).

If you want to return to the first display, from the Tool menu, select Graph settings. Then, select
Auto for X Axis.

Expanding and reducing the Y-axis
Drag the

icon to move the data line up and down.

Right-drag the
icon to move the zoom point. If you select the display resolution when Y axis
setting, expanding or reducing takes place with the zoom point at the center. If Y axis setting is
selected, scroll with the mouse wheel to expand or reduce the selected axis.
If you want to return to the first display, from the Tool menu, select Graph settings. Then, select
Auto for Y Axis.

Showing or hiding Cursor, Cursor Measure, Normal Data, and Rest Data
Right-click in the graph area and select Display Settings. Then select Enable Cursor, Enable cursor
Measure, Enable Normal Data, or Enable Rest Data to show or hide the corresponding item.
Normal Data

Cursor

Rest Data

Between cursors A and B

Measured values at cursors A and B
Item
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Description

Cursor

Shows or hides cursors A and B.
Hiding them also hides the measurement values.

Cursor Measure

Shows or hides measurement values.

Normal Data

Shows or hides standard measurement data.
Hiding it will cause only high-speed sampling data to be shown.

Rest Data

Shows or hides rest state data.
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Displaying Profile Graphs

Text Area
On the Result tab, double-clicking a profile displays the selected profile in the graph area. The
process to display in the graph area begins 3 seconds after double-clicking.
It may take some time to display the graph. We recommend that you check the test result text first
and then display it in the graph pane.

Cycle No.0

Cycle No.1

Cycle No.2
Cycle No.3

Tab

BPChecker3000 Graph Viewer

Description

Result

Displays profile’s test results.
Cycle numbers are serial numbers that are assigned to profiles. The cycle
number starts from zero.

Normal Data

Displays standard measurement data.

High Speed

Displays high-speed sampling data.

Overlap

Displays overlapped graph information.
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Displaying I-V characteristic Graphs
I-V characteristic graphs are generated based on the measurement results of battery voltage and
charge/discharge current when the charge/discharge current is varied in step increments.
The I-V characteristic graph is displayed on the I-V characteristic tab in the graph pane. You can set
up to two items on the Y axis.

Displaying the I-V characteristic graph
There are two methods to create an I-V graph. One method is to use a wizard to extract relevant
data and create the graph automatically. The other method is to set sampling number (standard
measurement data number) points one by one to create the graph.
The setting conditions of I-V characteristic cannot be saved. When you close GraphViewer, the
name of the setting conditions and the conditions themselves are cleared.

Creating the I-V characteristic graph automatically
The automatic generation of I-V characteristic graph is valid if steps are automatically configured
when an I-V characteristic profile is created on Test Condition Editor. If an I-V characteristic graph is
created automatically from the test results of an I-V characteristic profile whose steps have not
been configured automatically, a correct graph will not be displayed.
See

p. 100

1
2
3

4
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On the Profile tab, display the profile that you want to analyze the I-V
characteristic of.
Click the I-V tab.
From the Data menu, select Analysis of I-V.
An Analysis of I-V window appears.

Enter the name for the setting conditions.
The I-V characteristic name is used when displaying overlapped graphs.
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Displaying I-V characteristic Graphs
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5

Click

6

Select Extraction target (Charge/Discharge) and on position (First position of
the ON-Period/Last position of the ON-Period).

7

Click OK.

.

An Analysis Wizard of I-V window appears.

The I-V characteristic graph appears.
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Displaying I-V characteristic Graphs

Creating the I-V characteristic graph by selecting specific points
See

p. 100

1
2
3

4
5
6
7

On the Profile tab, display the profile that you want to analyze the I-V
characteristic of.
Click the I-V tab.
From the Data menu, select Analysis of I-V.
An Analysis of I-V window appears.

Enter the name for the setting conditions.
The I-V characteristic name is used when displaying overlapped graphs.

Click

to add the combination.

Find the off position from Normal Data.
Double-click “off” under Combination, and enter the sampling number
selected in step 6.

8 Likewise, set the number for “on.”
9 Repeat steps 5 to 8.
selecting the points, click OK.
10 After
The I-V characteristic graph appears.
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Displaying I-V characteristic Graphs

Even if you want to create the I-V characteristic graph by specifying the sampling numbers one by
one, we recommend that you use the wizard to extract the data and then reselecting the sampling
numbers.

Editing Combination
Click

to add a combination line.

To insert a combination between two lines, select the first line and click
To delete a combination, select it, and click
To move a combination up, select it, and click
click

.

.
. To move a combination down, select it, and

.

Double-clicking “off” or “on” of an already set combination enables you to change the selected
point.

Graph Area

Y1

Y1 axis setting Y2

Y2 axis setting

Sampling point

Move Y1 axis

Item
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Move Y2 axis

Description

Y1
Y2

Selects the item (None, Resistance, or Delta Voltage) to display on
the Y-axis.

Y1 axis setting
Y2 axis setting

Expands or reduces the Y-axis
This appears when the item assigned to the Y-axis is not None.

Move Y1 axis
Move Y2 axis

Drag to move the data line up and down.
Right-drag to move the Y-axis zoom point (center of Y-axis zooming) up
and down.
This appears when the item assigned to the Y-axis is not None.

Sampling point

Displays standard measurement data points as dots.
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Displaying I-V characteristic Graphs

Text Area
Item
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Description

I-V Data

Displays the I-V characteristic data.

I-V Overlap

Displays an overlapped graph of I-V characteristics.
See：p. 113
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Displaying Life Graph
Life graphs can be displayed on the Life tab. Life graphs show changes in the DUT
(battery) capacity. You can set up to four items on the Y axis.

Displaying life graphs
You can display the life graph of the present test result file and that of another test result file.
The setting conditions of life graphs cannot be saved. When you close GraphViewer, the name of
the setting conditions and the conditions themselves are cleared.

1
2

3
4

Click the Life tab.
From the Data menu, select Analysis of Life.
An Analysis of Life window appears.

Enter the name for the setting conditions.
The life name is used when display overlapped graphs or when setting conditions are
saved.

To analyze the life of the test result file that is currently open, select Use
Current Project File. To analyze the life of another test result file, select Use
Other Project File.
To analyze another test result file, select Use Other Project File and then click Select to
choose the test result file.
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109

Displaying Life Graph

5

Under Filter, select the cycle number you want to display.
Keywords are items that were entered when you created the profile.

Search range

Keywords

Filter
Search range

Keywords

Description
All

Selects from all cycles.

Scope
(Min/ Max)

Selects from a range of specified cycles.
You can view the cycle numbers on the Result tab of the Profile
tab. The first cycle number is zero.

Profile Name

Selects the profile to display.
Select None to not select.

Category1
Category2

Selects the profile category to display.
Select None to not select.

Count

Number of cycles that satisfy the search range and keyword
search conditions.

6

To analyze the life of another test result file, select Unit of capacity.

7

Set Base Cycle Count.

This is available when Unit of Capacity is set in the Graph settings.

The first displayed number is the serial number of the applicable profile. The number in
parentheses is the cycle number.
The selected cycle number is assigned to 100 % of the Y-axis and becomes the reference
for other profiles.

8

110

Click OK.
The life graph is displayed.
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Displaying Life Graph

Graph Area
Y1 axis setting

Y2 axis setting
Y2

Y1

Y3 axis setting
Y3

Y4 axis setting
Y4

Sampling point

Move Y1 axis

Move Y2 axis

Move Y3 axis

Item
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Move y4 axis

Description

Y1
Y2
Y3
Y4

Selects the item (None, Capacity, Power, ElapsedTime, cutVoltage,
CutCurrent, CutTemperature, EndsOC, CellCutVoltage, CapacityRatio,
PowerRatio, ElapsedTimeRatio, CutVoltageRatio, CutCurrentRatio,
utTemperatureRatio/ EndSOCRatio/ CellCutVoltageRatio/
CellUnbalanfeRatio/ CellCutTemperatureRatio) to display on the Yaxis.

Y1 Axis setting
Y2 Axis setting
Y3 Axis setting
Y4 Axis setting

Expands or reduces the Y-axis
This appears when the item assigned to the Y-axis is not None.

Move Y1 axis
Move Y2 axis
Move Y3 axis
Move Y4 axis

Drag to move the data line up and down.
Right-drag to move the Y-axis zoom point (center of Y-axis zooming) up
and down.
This appears when the item assigned to the Y-axis is not None.

Sampling point

Displays standard measurement data points as dots.
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Displaying Life Graph

Text Area
Analyzing the life of another test result and overlapping the graph enables you to compare the life
of different batteries.
Item

112

Description

Life Data

Displays the live data.

Life Overlap

Displays an overlapped graph of life.
See p. 113.
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Displaying Overlapped Graph
Multiple data lines can be overlapped.

Displaying overlapped graphs
Right-clicking in the graph area and selecting Add Overlap locks the currently displayed data line.
This data line does not disappear even when you select another data line. When you display
another data line, the graphs become overlapped.
The data lines that are enabled in the text area are displayed.

Show or hide the data line.

The data line displayed in the first line is the currently selected profile (reference).
When you zoom the overlapped graphs, cursors A and B are snapped to the standard measurement
data of the reference data.
If you want to change the reference data, select the appropriate profile on the Result tab of the
overview pane, project pane, or graph pane.
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Displaying Overlapped Graph

Overlapping graphs by specifying conditions (profile graph)
You can specify the conditions of overlapped profile graphs.
The setting conditions cannot be saved. When you close GraphViewer, the setting conditions are
cleared.

1

From the Data menu, select Overlap.

2

Under Filter, select the cycle number you want to display.

An Overlap window wondow appears.

Keywords are items that were entered when you created the profile.

Search range

Keywords

Filter
Search range

Keywords

Count

3
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Description
All

Selects from all cycles.

Scope
(Min/ Max)

Selects from a range of specified cycles.
You can view the cycle numbers on the Result tab of the Profile
tab. The first cycle number is zero.

Profile Name

Selects the profile to display.
Select None to not select.

Category1
Category2

Selects the profile category to display.
Select None to not select.
Number of cycles that satisfy the search range and keyword
search conditions.

Click OK.
The overlapped profile graphs are displayed.
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Displaying Overlapped Graph

Exporting the overlapped graph information (profile graph only)
The path to the overlapped profile data of overlapped profile graphs can be exported.
Even if you close GraphViewer, you can restore the overlapped graph as long as you do not move
the test result data.
On the OverLap tab, select the profile that you want to export, right-click, and select Export. You
can select multiple profiles by using the SHIFT or CONTROL key. Reference data cannot be
exported.
The exported file contains the absolute paths to the selected profile data.
If you move the test result data files or move the exported file to another PC, importing will no
longer be possible. An illustration of what the exported file contains is shown below.

On the Overlap tab, right-clicking and selecting Import adds the exported contents.
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Displaying Overlapped Graph

Displaying other test result graphs for comparison
Other test result data lines can be displayed in profile graphs and life graphs.

Displaying the profile graph of another test result in the profile graph
In the profile graph, you can copy the data of the overlapped graph to the Clipboard or export the
data path.
If you open another test result file and paste or import, an overlapped graph can be displayed with
the profile graph of different test results.

Using copy and paste to overlap graphs
On the OverLap tab, select the profile that you want to copy, right-click, and select Copy. You can
select multiple profiles by using the SHIFT or CONTROL key. Reference data cannot be copied.
Open a different test result graph, and on the Overlap tab, right-click and select Paste to add the
copied contents.

Using import and export to overlap graphs
On the OverLap tab, select the profile that you want to export, right-click, and select Export. You
can select multiple profiles by using the SHIFT or CONTROL key. Reference data cannot be
exported.
Open a different test result graph, and on the Overlap tab, right-click and select Import to add the
exported contents.

Displaying the life graph of another test result in the life graph
Create a life graph, right-click, and select Add Overlap to lock the graph. Then, create the life graph
of another file.
To compare batteries with different capacities, when you create the life graph of the file, from the
Tool menu, select Graph settings, and set Unit of Capacity. Creating the life graph in this way will
make it easier to compare the graphs.

Removing data lines from overlapped graphs
On the Overlap tab of the text area, select the profile that you want to delete, right-click, and select
Remove to delete the selected profile. You can select multiple profiles by using the SHIFT or
CONTROL key.
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Changeing the Graph Viewer Display
Displaying thumbnails
From the Tool menu, select Thumbnail settings to change the thumbnail display in the project
pane.

Select the items you want to display, and click OK. The selected items are displayed in the
thumbnail area.

Vertically splitting the graph pane
The graph area and the text area of the graph pane can be displayed side by side.

Right-click in the graph area and select Display Settings and then Split Vertically to vertically split
the graph area. Selecting Split Vertically again causes the graph area to return to a horizontally split
display.
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Changeing the Graph Viewer Display

Displaying sampling markers
Sampling markers (standard measurement data points) can be displayed on the graph.

Right-click in the graph area and select Display Settings > Enable Sampling Marker to display a data
line with sampling markers. Selecting Enable Sampling Marker again hides the sampling markers.
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Changeing the Graph Viewer Display

Displaying the graph pane
On the Tool menu, click Graph Settings. You can change the display items and colors of the graph
pane.
Use tabs to switch between Graph Area and Cell.
To save the graph settings, on the Tool menu, click Export. To load saved settings, on the Tool menu,
click Import.

Graph Area tab
You can set the colors of waveforms displayed in the graph pane, the number of divisions in the
axes, line width, current polarity, unit of capacity, and time unit.

 Changing the displayed colors (Back Color, Outside Color, Inside Color, Scale
Color)
Click the color of an item that you want to change to open a Color window. Select the color you
want to use, and click OK.

X Axis Split/ Y Axis Split
You can set the number of divisions in the X-axis/ Y-axis.

Changing the data line width
You can set the the data line width.

Current Polarity
Select whether to display charge/discharge on the positive or negative side of the X-axis. This is
synchronized with the current polarity setting of Test Condition Editor.

Unit of Capacity
You can select the unit of capacity and volume measurement for displaying capacities.
This setting is useful when you compare batteries with different capacities on the life graph.
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Changeing the Graph Viewer Display

Time Unit
You can select the unit for displaying the time.

Resetting the graph area zooming and changing the data line colors (axis)
You can apply these settings to the profile graph, I-V characteristic graph, and life graph, separately.
•

changing the draw range of the X-axis.
If you use cursors A and B to zoom the X-axis, the Auto check box in the X-axis is automatically
cleared. If you select the check box, the original display is restored.

•

Resetting the Y-axis draw range
Changing the Y-axis zoom point on the graph area automatically clears the auto check box of
the Y-axis, and the reference value is entered automatically. You can also move the zoom point
by entering a value. Selecting the check box restores the original display.
You can set the data line colors.

Cell tab
These settings are valid when you are using the optional board in the test conditions.

If you select the Cell Voltage Min, Max Fill or Cell Temperature Min, Max Fill check boxes, the area
between the maximum values and minimum values of the terminals assigned to a group is filled
with the specified color.
If you clear the check boxes, you will be able to select the cell terminal to display the maximum and
minimum values of.
If you want to view the maximum and minimum cell voltages, selecting “Cell Voltage Min, Max Fill”
or “Cell Temperature Min, Max Fill” results in faster drawing speed than selecting all cell terminals.
You can select multiple cells using the SHIFT and CONTROL keys, right-click, and select Enable or
Disable to collectively set the items.
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PrintingGraphs
To print, activate the graph pane tab that you want to print, and on the File menu, click Print and
then Print. If you want to view the print preview, on the File menu, click Print and then Print Preview.
To print in gray scale, on the File menu, click Print and then Gray Scale.
On the Profile tab and I-V characteristic tab, you can select from the File menu, Print, Print Settings,
and then Print Result, Print General, or Print Condition to print the selected content with the graph.

Entering comments on graphs
Comments can be displayed in the graph area. It can be used to identify graphs when the graphs
are printed in gray scale.

Displaying comments

1
2

Right-click in the graph area.
Select Add a comment.
“Comment” appears in the graph area.

3

Double-click “Comment” and edit the content.

4

Drag the comment to the desired location.

After editing, click ×.

Comments are displayed separately on the profile tab, I-V characteristic tab, and life tab.
The content and the position of a comment does not change even if you switch to another
graph on the same tab.

Editing comments
Select the comment you want to edit, and right-click.
Select Edit to change the content of the comment.
Select Font Size to change the font size.
Select Remove to remove the selected comment.

Deleting all comments

1
2
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Right-click in the graph area.
Click Remove Comment.
All comments will be deleted.
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Menu Reference
Menu
File

Data

Tool

Help
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Description
Open

Open graphs from a test result file (life).

Close

Closes graphs.

Print

Displays the Print context menu in graph pane.

Resent File

Open a recent file.

Exit

Closes the Graph Viewer.

Overlap

Configure overlapped graphs.

Analysis of I-V

Configure the I-V graph settings.

Analysis of Life

Configure life graph settings.

Thumbnail settings

Configure the thumbnail display.

Graph settings

Configure the Graph Viewer settings.

Import

Load graph settings.

Export

Export graph settings.

Version

Displays the Graph Viewer information.

Help

Displays a help file.
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If you find any misplaced or missing pages in the manuals, they will be replaced. If the
manual gets lost or soiled, a new copy can be provided for a fee. In either case, please
contact your Kikusui agent or distributor. At that time, inform your agent or distributor of
the “Part No.” written on the front cover of this manual.
Every effort has been made to ensure the accuracy of this manual. However, if you have
any questions or find any errors or omissions, please contact your Kikusui agent or
distributor.
After you have finished reading this manual, store it so that you can use it for reference
at any time.
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1-1-3 Higashiyamata, Tsuzuki-ku, Yokohama,
224-0023, Japan
Tel: +81-45-482-6353 Fax: +81-45-482-6261
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